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SZÉCHENYI ISTVÁN ALKALMAZOTT MECHANIKA 
 EGYETEM TANSZÉK 

 
 

Végeselem módszer 7. gyakorlat  

Oszlopos fúró sajátfrekvencia- és szilárdságtani vizsgálata  
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Adott: 

Anyag:  52 10 MPaE   , 0,3  , 
9

3 3
7850 7,85 10

kg t

m mm
     

Terhelés: 100 NyF  és 10 NmcM   

 

KM száma KM neve 
KM 

típusa 
a méret [mm] b méret [mm] r sugár [mm] 

(1) géptest téglalap 300 500  

(2) asztal téglalap 400 20  

(3) asztal tartó téglalap 100 40  

(4) alap téglalap 600 100  

(5) oszlop kör   50 

(6) asztal tartó oszlop  kör   60 

(7) oszlop kör   50 

(8) főtengely kör   40 

(9) szerszámbefogó kör   20 

(10) szerszám kör   10 

 

 

Feladatok: 1. Sajátfrekvencia vizsgálat (itt nem kell terhelés csak megfogás) 

 2. Szilárdságtani vizsgálat  

 

Végeselem modell/háló: húzott-nyomott, hajlított-nyírt rúdelem. Elem méret 10 mm legyen.  

 

Szemléltetés:  

 Az első 20 sajátfrekvencia meghatározása.  

 Az első 20 sajátfrekvenciához tartozó lengésképek kirajzoltatása.  

 A szerkezet lengésének kirajzoltatása. 

 A szerkezet elmozdulás állapotának meghatározása, az adott terhelésrere.   

 A legnagyobb elmozdulás helyének megkeresése és elmozdulás értékének kiíratása. 
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Indítsuk el az Abaqus CAE programot. Adjuk meg a munkakönyvtárat a File ► Set 

Work Directory… paranccsal. A megjelenő ablakban a New work directory alá 

írjuk/másoljuk be a munkakönyvtárunk helyét, vagy válasszuk ki a A select… ikonnal. 

Ezután OK-zuk le az ablakot. 

  
 

 

A program megnyitása után alapértelmezésként a Part Modulban vagyunk. Ez a Modul 

szolgál a geometria létrehozására. Ehhez az alábbi lépéseket kövessük: 

 

1. Az eszköztárból kattintsunk a Create Part ikonra. Az ennek hatására megjelenő Create 

Part ablakban az alábbi beállításokat végezzük el: 

 A Name után írjuk be az alkatrészünk nevét. 

 A Modeling Space alatt válasszuk ki, hogy síkbeli, azaz 3D geometriát 

szeretnénk rajzolni. 

 A Type alatt hagyjuk az alapértelmezett kijelölést a Deformable előtt, mivel 

alakváltozásra képes geometriát szeretnénk. 

 A Base Feature alatt válasszuk a Wire-t, mivel a rudakat vonalakkal fogjuk 

definiálni. 

 Az Approximate size-ot, tehát a modellünk méretét itt is beállíthatnánk, írjunk be 

1000-et. 

A fenti beállítások elvégzése után kattintsunk lent a Continue… gombra. 

  
A1.1 A1.2 

A MODULE │ PART geometria megrajzolása 
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2. A geometria megrajzolásához válasszuk az eszköztárból a Create Lines: Connected 

parancsot. Ezután rajzoljunk meg a geometriát hasonlóra mint a végleges.   

 Ha végeztünk a geometria megrajzolásával nyomjuk meg az Esc billentyűt. 

Ezt követően méretezzük be a megrajzolt vonalat, ehhez válasszuk, az Add Dimension 

parancsot.  

 Kattintsunk a vonalakra és méretezzük be azokat pontosan a lenti ábrának 

megfelelően.  

Ahhoz, hogy a vázlatból vonalakból álló alkatrész legyen, a lenti beviteli mezőben 

kattintsunk a Sketch the section for the wire melletti Done gombra (vagy nyomjuk meg a 

középső egérgombot) Ennek hatására elkészül a Part-unk, és visszaáll a Part Modul alap 

eszköztára. 

 

A3.2 

 

 

 

A3.4 

A3.5 

A3.1 A3.3 
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B MODULE │ PROPERTY tulajdonságok megadása 
 

Válasszuk ki fent a Property modult. Itt tudjuk megadni az anyagjellemzőket, illetve rúd esetén 

a keresztmetszeti jellemzőket. Ehhez az alábbi 3 lépésen kell végmenni: 

 

1. Anyag definiálása: Első lépésként egy anyagot kell definiálnunk. Ehhez a Property modul 

eszköztárából kattintsunk a Create Material ikonra. A megjelenő Edit Material ablakban 

végezzük el a következő beállításokat: 

 Nevezzük el az anyagot: a Name: után írjuk be, hogy acél 

 A lineárisan rugalmas anyagjellemzők megadásához a Material Behaviors 

mezőben adjuk ki a Mechanical ► Elasticity ► Elastic parancsot 

 Az ekkor megjelenő Elastic mezőben az alábbi beállításokat végezzük el: 

o A Type mellett hagyjuk az alapértelmezett Isotropic-ot (az 

anyagtulajdonságok irányfüggetlenek) 

o A lenti Data táblázatban a Young’s Modulus alá írjuk be a rugalmassági 

tényezőt, azaz 2e5 (MPa) –t, a Poisson’s Ratio alá pedig a Poisson 

tényezőt, azaz 0.3-at.  

 Dinamikai feladathoz még egy anyagjellemzőt meg kell adni mégpedig a 

sűrűséget. Válasszuk a General ► Density parancsot. 

 A megjelenő Mass Density alá írjuk be az acél sűrűségének értékét t/mm3 

mértékegységgel, vagyis 7.85e-9 –et.  

 

 

   
B1.1 B1.2 B1.3 
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 B1.4 B1.5 

 

2. Keresztmetszet profiljainak definiálása (9db): A Property Modul eszköztárából kattintsunk 

a Create Profile ikonra és adjuk meg a lenti táblázatban látható keresztmetszeteket.  A 

megjelenő Create Prolife ablakban az alábbi beállításokat végezzük el: 

 Nevezzük el a keresztmetszetet. 

 A Shape alatt válasszuk ki a Rectangular –t téglalap KM megadásához és a 

Circular-t kör KM megadásához.  

Ezután kattintsunk a Continue… gombra. Az ekkor megjelenő Edit Profile ablakban 

adjuk meg a KM táblázatban látható pontos méreteit. Ezután kattintsunk az OK 

gombra. 

 

KM száma KM neve 
KM 

típusa 
a méret 

[mm] 
b méret 

[mm] 
r sugár 
[mm] 

(1) géptest téglalap 300 500  

(2) asztal téglalap 400 20  

(3) asztal tartó téglalap 100 40  

(4) alap téglalap 600 100  

(5) oszlop kör   50 

(6) asztaltartó oszlop kör   60 

(7) főtengely kör   40 

(8) szerszámbefogó kör   20 

(9) szerszám kör   10 
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B2.1 B2.2 B2.3 

  
 

B2.4 B2.5 B2.6 

 

3. Keresztmetszetek definiálása (9db): A Property Modul eszköztárából kattintsunk a 

Create Section ikonra. Az ekkor megjelenő Create Section ablakban az alábbi 

beállításokat végezzük el: 

 Nevezzük el a keresztmetszetet.  

 A Category alatt válasszuk ki a Beam –t (rúd) 

 A Type alatt válasszuk a Beam –t  

Ezután kattintsunk a Continue… gombra. Az ekkor megjelenő Edit Section ablakban 

a Material mellett megjelent az előző pontban definiált acél (többféle anyag esetén itt 

választhatnánk ki a kívánt anyagot), illetve a Profile name mellett pedig a korábban 

megadott szelvények. Ezek közül válasszuk ki a megfelelőt. Ezután kattintsunk az OK 

gombra. 
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B3.1 B3.2 B3.3 

 

4. Keresztmetszet rudakhoz rendelése: A 2. pontban a kersztmetszethez már 

hozzárendeltük az anyagot, így most már csak az előző pontban definiált 

keresztmetszetet kell hozzárendelni a rudakhoz. Ehhez kattintsunk a Property modul 

eszköztárából az Assign Section ikonra. Ezután jelöljük ki a KM-nek megfelelő rudakat, 

majd a lenti beviteli mezőben kattintsunk a Done gombra. Ekkor megjelenik az Edit 

Section Assignement ablak, ahol kiválaszthatjuk a keresztmetszetet. Mivel csak egy 

keresztmetszetet definiáltunk, hagyjuk a Section melletti kör kersztmetszetet és csak OK-

zuk le az ablakot. 

 

B4.2 

 

B4.1 B4.3 
 

 

5. Keresztmetszet orientációjának megadása: Végül adjuk meg a keresztmetszet 

profiljának orientációját az Assign Beam Orientation paranccsal.  Ezután jelöljük ki 

egyesével a rudakat külön-külön, majd a lenti beviteli mezőben kattintsunk a Done 

gombra. Ekkor megjelenik az orientációt jelölő nyilak az ábrán látható módon, kattintsunk 

a középső gombbal. Majd még kétszer fogadjuk el a beviteli mezőben megjelenő 

adatokat a középső gombbal.  

A View ► Part Display Options… menüben a Render Beam Profiles opciót kapcsoljuk 

be így látjuk a tartóhoz rendelt négyzet szelvényt.  
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A5.2 

 

A5.3 

 

A5.4 

 

A5.1 A5.5 

 
 

C MODULE │ ASSEMBLY összeállítás 
 

Ennek a lépésnek több alkatrészből álló szerkezetek esetében van igazán jelentősége, mivel 

itt tudjuk létrehozni az összeállítást. Jelenleg csak egy alkatrészünk van, ennek ellenére nem 

hagyható ki a lépés, készítenünk kell egy egy alkatrészből álló összeállítást. Ehhez kattintsunk 

az Assembly modul Create Instance ikonjára, majd a megjelenő ablakot OK-zuk le. 
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C1 C2 

 

D MODULE │ STEP lépések megadása 
 

A Step modulban a végrehajtandó vizsgálat(ok) típusát (pl. statikus, dinamikus, hőtani…), azok 

részleteit és sorrendjét tudjuk beállítani. Először egy sajátfrekvencia vizsgálatot. Ehhez 

kattintsunk a Step modul Create Step ikonjára. a megjelenő Create Step ablakban nevezzük 

el a lépést. A Procedure type-nál válasszuk a Linear perturbation-t és azon belül a 

Frequency-t. Ezután kattintsunk a Continue… gombra, majd a megjelenő Edit Setup 

ablakban kattintsunk a Number of eigenvalues requested opciónál a Value-ra majd adjunk 

meg 20-at, vagyis a program az első 20 sajátfrekvenciát fogja kiszámolni, eztuán OK-zuk le. 

 

 

 

 

D1 D2 D3 

 

D MODULE │ LOAD peremfeltételek megadása 
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A Load modulban tudjuk megadni a kinematikai peremfeltételeket (megfogásokat) és 

dinamikai peremfeltételeket (terheléseket). Jelen feladatban a sajátfrekvencia vizsgálathoz 

csak 1 megfogást (fix) kell definiálni, terhelést nem. 

 

1. megfogások definiálása:  

 Kattintsunk a Load modul Create Boundary Condition ikonjára. 

 A megjelenő Create Boundary Condition ablakban nevezzük el a megfogást, a 

Category-t hagyjuk az alapértelmezett Mechanical-on, a Types for Selected Step 

alatt pedig válasszuk ki a Displacement/Rotation-t. Ezután kattintsunk a 

Continue… gombra.  

 Jelöljük ki a rajzon a fix megfogás helyét (kijelöléskor egy kis piros pont jelenik meg 

a kijelölés helyén). 

 A lenti beviteli mezőben kattintsunk a Done-re 

 Az ekkor megjelenő Edit Boundary Condition ablakban akadályozzuk meg az X és 

Y irányú elmozdulást, és Z tengely körüli elfordulást. Ehhez az U1, U2 és UR3 előtti 

négyzeteket, pipáljuk be. OK-zuk le az ablakot. 

csukló megadása 

 
E1.1 

 
E1.2 

 
E1.3 

 
E1.4 
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E1.5 

 

 

 

 

F MODULE │ MESH háló elkészítése 
 

A végeselem hálót a Mesh modulban tudjuk elkészíteni. Legelőször fent az Object-et állítsuk 

át Part-ra, aminek hatására a Part mellett megjelenik a rácsos tartó felirat. 

 
Ezután a hálózást az alábbi lépésekben végezzük el: 

1. Elemtípus megadása: 

 Kattintsunk a Mesh modul Assign Element Type ikonjára. 

 Jelöljük ki a teljes tartót, mivel minden rúdhoz ugyanolyan elemtípust szeretnénk 

rendelni. 

 A lenti beviteli mezőben kattintsunk a Done gombra 

 A megjelenő Element Type ablakban a Family-t állítsuk Beam-re, azaz húzott-

nyomott-hajlított-nyírt rúdelemre, majd OK-zuk le az ablakot. 
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F1.2 

  

F1.1 F1.3 
 

F1.4 

 

2. Elemméret megadása: 

Ehhez az alábbi lépéseket végezzük el: 

 Kattintsunk a Mesh modul Seed Edges ikonjára. 

 Jelöljük ki az egész tartót. 

 A lenti beviteli mezőben kattintsunk a Done gombra. 

 A megjelenő Local Seeds ablakban a Basic fülön a Method-nál pipáljuk be a By 

size opciót és lent a Sizing Controls mezőben az Approximate element size-hoz 

írjunk be 10-et. Ezután OK-zuk le az ablakot. 

 

F2.2 

  
F2.1 F2.3  F2.4 

3. Végeselem háló elkészítése: 

A végeselem háló elkészítéséhez kattintsunk a Mesh modul eszköztárában a Mesh Part 

ikonra, majd a lenti beviteli mezőben az OK to mesh the part? mellett a Yes gombra. 

 

 
 

F3.1 F3.2 
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4. Hálótulajdonságok lekérdezése (opcionális) 

A csomópontok és végeselemek számának ellenőrzéséhez a Tools ► Query… 

Parancsot használhatjuk. A felugró Query ablakban a General Queries mezőben 

kattintsunk a Mesh-re, majd a lenti beviteli mezőt a Query entire part-on hagyva a Done 

gombra. Ekkor a lenti párbeszédablakban megjelenik a csomópont szám (Total number 

of nodes) és az elemszám (Total number of elements).  

 
 

 

E4.3 

 

E4.1 E4.2 E4.4 

 

G MODULE │ JOB feladat megoldása 
 

A feladatot a Job modulba átlépve tudjuk lefuttatni. Az ehhez szükséges lépések: 

1. Feladat definiálása: 

 A Job modul eszköztárából kattintsunk a Create Job ikonra 

 A megjelenő Create Job ablakban kattintsunk a Continue… gombra 

 A megjelenő Edit Job ablakban hagyjunk mindent alapértelmezésen és OK-zuk le 

 

  
G1.1 G1.2 G1.3 

2. Feladat lefuttatása: 

 A Job modul eszköztárából kattintsunk a Job Manager ikonra 

 A megjelenő Job manager ablakban alapból ki van választva az előbb definiált 1 

db feladat (Job-1). Kattintsunk a Submit gombra. 

 Ha a Status alatt megjelenik a Completed felirat, akkor a feladat sikeresen lefutott. 

Az eredmények megjelenítéséhez kattintsunk a Results gombra. 

   
G2.1 G2.2 G2.3 
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H MODULE │ VISUALIZATION eredmények megjelenítése 
 

A Results gombra kattintva automatikusan a Visualisation modulba kerülünk. Fent válasszuk 

ki az U-t, hogy az elmozdulást jelenítsük meg.  

A Plot Contours on Deformed Shape ikonra kattintva az adott sajátfrekvencián fellépő 

lengésképeket látjuk. A sajátfrekvenciák között a jobb sarokban lévő  ikonokkal 

tudunk léptetni. Hogy hányadik sajátfrekvenciához tartozó lengésképet ábrázolja a program, 

azt a grafikus ablakon alul megjelenő szöveges részben látjuk. A Mode –nál látjuk, hogy 

hányadik sajátfrekvenciáról van szó és a Freq-nél pedig az adott sajátfrekvencia értéket.  

Mode=1 – első sajátfrekvencia 

Value =1669 – első sajátkörfrekvencia 

négyzete 2   

Freq= 6,5021 Hz – első sajátfrekvencia 

értéke  

2 1669
6,5021

2 2
f Hz



 
    

Periódusidő 
1 1

0,165
6,0521

T s
f

    
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Az 1. feladatot (sajátérték feladat) megoldottuk a következőkben a 2. feladatot, vagyis a 

dinamikai feladatot oldjuk meg.  

 

 

D MODULE │ STEP lépések megadása 
 

A Step modulba visszalépve töröljük az első feladatban létrehozott step-et. Ehhez kattintsunk 

a Step Manager-re és ott a Step-1-et kijelölve kattintsunk a Delete… gombra. Majd ugyan itt 

hozzunk létre egy új Static, General step-et. Kattintsunk a Create… gombra a felugró ablakban 

válasszuk a Static, General opciót majd Continue. A felugró Edit Step ablakot OK-zuk le. 

Végül zárjuk be a Step Manager ablakot.  

 

 

 
D1 D2 D3 

 

 

D4 D5 

 

 

D MODULE │ LOAD peremfeltételek megadása 
 

A Load modulban tudjuk megadni a kinematikai peremfeltételeket (megfogásokat) és 

dinamikai peremfeltételeket (terheléseket). A feladat során működni fog a fix megfogás az alsó 

rúdra illetve az erő és csavaró nyomaték a fúrószár végére.  
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1. megfogások definiálása:  

 Kattintsunk a Load modul Create Boundary Condition ikonjára. 

 A megjelenő Create Boundary Condition ablakban nevezzük el a megfogást, a 

Category-t hagyjuk az alapértelmezett Mechanical-on, a Types for Selected Step 

alatt pedig válasszuk ki a Displacement/Rotation-t. Ezután kattintsunk a 

Continue… gombra.  

 Jelöljük ki a rajzon a fix megfogás helyét, az alsó rudat (kijelöléskor egy kis piros 

vonal jelenik meg a kijelölés helyén). 

 A lenti beviteli mezőben kattintsunk a Done-re 

 Az ekkor megjelenő Edit Boundary Condition ablakban akadályozzuk meg az X,Y,Z 

irányú elmozdulást, és az X,Y,Z tengely körüli elfordulást. Ehhez az U1, U2, U3, 

UR1, UR2, UR3 előtti négyzeteket, pipáljuk be. OK-zuk le az ablakot. 

 

 

 

fix megfogás megadása 

 
E1.1 

 
E1.2 

 
E1.3 

 

 
 
 

E1.4 

 

 
E1.5 
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2. terhelések definiálása: 

 Kattintsunk a Load modul Create Load ikonjára. 

 A megjelenő Create Load ablakban nevezzük el az adott terhelést. . A Category-t 

hagyjuk az alapértelmezett Mechanical-on, a Types for Selected Step alatt pedig 

válasszuk ki a Concentrated force-t koncentrált erő megadáshoz és Moment-et a 

csavaró nyomaték megadásához. A Step ablakban pedig válasszuk a Step-1-et. 

Ezután kattintsunk a Continue… gombra.  

 Jelöljük ki a rajzon a terhelés helyét. (kijelöléskor egy kis piros pont illetve piros 

vonal jelenik meg a kijelölés helyén). 

 A lenti beviteli mezőben kattintsunk a Done-re 

 Az ekkor megjelenő Edit Load ablakban adjuk meg az erőkomponensek nagyságát 

N-ban: CF2=100 koncentrált erő esetén és CM2=10000 csavaró nyomaték esetén.  

 

Csavaró nyomaték megadása Koncentrált erő megadása 

  

E2.1 E2.6 

  
E2.2 E2.7 

  
E2.3 E2.8 

  

E2.4 E2.9 
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E2.5 E2.10 

 

 

G MODULE │ JOB feladat megoldása 
 

A feladatot a Job modulba átlépve tudjuk lefuttatni. Az ehhez szükséges lépések: 

1. Feladat definiálása: 

 A Job modul eszköztárából kattintsunk a Create Job ikonra és hozzunk létre egy 

kettes Job-ot.  

 A megjelenő Create Job ablakban kattintsunk a Continue… gombra 

 A megjelenő Edit Job ablakban hagyjunk mindent alapértelmezésen és OK-zuk le 

 

 
 

G1.1 G1.2 G1.3 

 

2. Feladat lefuttatása: 

 A Job modul eszköztárából kattintsunk a Job Manager ikonra 

 A megjelenő Job manager ablakban alapból ki van választva az előbb definiált Job-

2. Kattintsunk a Submit gombra. 

 Ha a Status alatt megjelenik a Completed felirat, akkor a feladat sikeresen lefutott. 

Az eredmények megjelenítéséhez kattintsunk a Results gombra. 
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G2.1 G2.2 G2.3 

 

H MODULE │ VISUALIZATION eredmények megjelenítése 
 

A Results gombra kattintva automatikusan a Visualisation modulba kerülünk. Fent válasszuk 

ki az U-t, hogy az elmozdulást jelenítsük meg.  

A Plot Contours on Deformed Shape ikonra kattintva a rúd pontjainak kitérését.  

 
 

Látványosabban látszik az eredmény, ha az Odb Display Options-on belül bekapcsoljuk a 

Render Beam Profiles opciót.  
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Redukált feszültség eloszlás ábrázolása.  

 
 


